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Importing Cargoes Sizes from External Database
The simplest way - Copy your Excel sheet and paste to CubeMaster manifest
You can copy the cells such as the list of the cargo names and sizes from your Excel sheet and paste them to
the cargo list of the CubeMaster program. Make a block with selecting the cells of your Excel sheet and press
Ctrl+C to copy the selections to the clipboard. After returning to the Setup page of the CubeMaster program,
click a first top left cell in the cargo list and press Ctrl+V to paste the selections there. Please repeat for all
necessary information of the sheet.

Figure 1 Copy the Excel cells and paste to the cargo list

Another simple way using the Excel/CSV Import Wizard
If you click From Excel or CSV File menu under the Add button in the Step 2: Cargo List or press F3 key,
the Excel/CSV Import Wizard window opens as pictured below. It allows you to provide the name of your
Excel or CSV file, define the columns in the file to be imported and preview the import.

Figure 2 Excel/CSV Import Wizard

This window contains the following components/fields.
Step 1: Open File: Enter the name of an Excel or CSV file which contains your cargo data such as cargo
name and sizes.
Step 2: Define Columns: Tell the wizard about the configurations of the file specified at the Step 1 such
as columns order, # of skip lines, name of Excel sheet and CSV separator.
Skip Lines: Enter the number of top rows in the file the import would skip.
Excel Sheet: Enter the name of sheet if the file is an Excel.
CSV Separator: Enter the letter of separator if the file is a CSV.
Columns #: Tell the wizard about which columns in your CSV file or Excel sheet go to what cargo
properties. Just assign the order of a column in your CSV file or Excel sheet to each Column # field.
The column order should start with 1 from the left to right in the CSV file. For example if a column
after first separator in a CSV file should go to the cargo name, you should enter 2 to the Column # of
the Name property. The available cargo properties are summarized at following table.
Cargo Properties
Group Name
Name
Qty
SetRatio
Length
Width
Height
Weight
Color

Seq.
Orientation

Floor Stack Type

Supports Others

Pallet
Overhang:Length
Overhang:Width
Max Layers
Description

Description
Group name of the cargo.
Name of the cargo.
Number of carton or order qty of the cargo.
Set ratio of the cargo. (E.g. 1.2)
Length of the cargo.
Width of the cargo.
Height of the cargo.
Weight of the cargo.
Color of cargo to be presented in the graphics (E,g, .255 for red,
65280 for green). See
‘C:\ProgramData\Logen\Shared\Doc\Packages.xls’ for more
detail.
Loading sequence. The smaller value place the cargo earlier in the
shipment.
A number to present the loading orientation permitted. One of the
following numbers are available.
1 = Permits orientation #1
2 = Permits orientation #2
3 = Permits orientation #1 and #2
4 = Permits orientation #3
8 = Permits orientation #4
12 = Permits orientation #3 and #4
16 = Permits orientation #5
32 = Permits orientation #6
63 = Permits all orientations (#1,2,3,4,5,6)
A number to present the floor stacking type of the cargo. One of
the following numbers are available.
0 = Best Fit
1 = Bottom Only
2 = No Bottom
A number to present whether the cargo is allowed to support other
cargoes or not. One of the following numbers are available.
0 = No
1 = Yes
A pallet name to be used at the palletizing rule. It should exist in
the pallet database.
Max length allowed for overhang on the pallet.
Max width allowed for overhang on the pallet.
Max number of layers allowed to the cargo.
Description of the cargo.

Alias1
Alias2
Property 1~10
Piece Inside
Group Name:Seq.

Alias 1 of the cargo.
Alias 2 of the cargo.
Property 1~10 of the cargo.
A number of pieces inside the cargo.
Loading sequence of the group contains the cargo.

Test to Preview Button: Click this button to test your configuration and see the imports in advance. The
imports will display at the list under Step 3: Preview group.
For better understand of the column definition,
‘C:\ProgramData\Logen\Shared\Doc\Packages.csv’.

please

see

the

sample

CSV

Importing from your existing DBMS to CubeMaster cargoes database
This option allows you to access your database directly and bring them to CubeMaster with OLEDB
connection. If you click From External DBMS menu under the Add button in the Step 2: Cargo List, the
External DBMS Import Wizard window opens as pictured below. It allows you to provide the location
of your DBMS, define the SQL to be executed for the import and preview the import.

Figure 3 Excel/CSV Import Wizard

This window contains the following components/fields.
Step 1: Define Connection: The connection statement should contain a provider of your database.
The default connection statement is “Provider= Microsoft.Jet.OLEDB.4.0; Data Source =
C:\ProgramData\Logen\Shared\Database\VMSDB2010.mdb;” which points to the local database
exists on your computer. Please see the following table to learn about other connection statement
samples. Please visit http://www.connectionstrings.com for more samples.

file

Database
MS Access 97, 2003, 2002,
2000

Connection Strings
Provider = Microsoft.Jet.OLEDB.4.0; Data Source =
C:\mydatabase.mdb; User Id = admin; Password = ;

MS Access 2013, 2010, 2007

Provider = Microsoft.ACE.OLEDB.12.0; Data Source =
C:\myFolder\myAccessFile.accdb; Persist Security Info = False;

SQL Server 2012, 2008,
2005, 2000, 7.0

Server = myServerAddress; Database = myDataBase; User Id =
myUsername; Password = myPassword;
For more information, please visit
http://www.connectionstrings.com/sql-server/

ORACLE

Data Source = MyOracleDB; User Id = myUsername; Password
= myPassword; Integrated Security = no;
For more information, please visit
http://www.connectionstrings.com/oracle/

MySQL

Server = myServerAddress; Database = myDataBase; Uid =
myUsername; Pwd = myPassword;
For more information, please visit
http://www.connectionstrings.com/mysql/

Step 2: Define SQL: Tells the wizard about the configurations of the SQL.
The default SQL is “select name as name, alias as alias, alias2 as alias2, groupname as groupname,
length as length, width as width, height as height, weight as weight, qty as qty, loaddir as orientation,
loadtype as stackvalue, color as color from MaterSKUList where qty > 50”. It defines what columns
should be selected and how they converted to CubeMaster cargo fields when the import is established.
As shown in the sample statement, it should contain the reserved field names as summarized in the
following table.
Fields
GroupName
Name
Description
Length
Width
Height
Weight
Qty
SetRatio
Orientation

Seq
StackValue
TurnAllowedOnFloor

Descriptions
Group name of the cargo.
Name of the cargo. Required column.
Description of the cargo. Required column.
Length of the cargo. Required column.
Width of the cargo. Required column.
Height of the cargo. Required column.
Weight of the cargo.
Number of carton or order qty. of the cargo.
Set ratio of the cargo.
Numbers to present the loading orientation of the cargo allowed. One
of the following numbers are available.
1 = Permits orientation #1
2 = Permits orientation #2
3 = Permits orientation #1 and #2
4 = Permits orientation #3
8 = Permits orientation #4
12 = Permits orientation #3 and #4
16 = Permits orientation #5
32 = Permits orientation #6
63 = Permits all orientations (#1,2,3,4,5,6)
Loading sequence of the cargo.
A stack value of the cargo. Utilized when the stacking rule 'Higher
stack values are placed bottom first'.
A number to present whether the turning orientations of the
cargo are allowed on the floor of the container or not. One of the
following numbers are available.

MaxLayersExtended

FloorStackType

SupportsOthers

SKUStyle

MaxLayer1
MaxLayer2
MaxLayer3
MaxLayer4
MaxLayer5
MaxLayer6
PieceInside
UnitPrice
Alias1
Alias2
Property 1~10
MaxSupportingWeight
Color

0 = No
1 = Yes
A number to present whether the max layers of the cargo are
extended on the other cargoes. One of the following numbers are
available.
0 = No
1 = Yes
A number to present the floor stacking type of the cargo. One of
the following numbers are available.
0 = Best Fit
1 = Bottom Only
2 = No Bottom
A number to present whether the cargo is allowed to support
other cargoes or not. One of the following numbers are available.
0 = No
1 = Yes
A value to present the style of the cargo. One of the following
numbers are available.
0 = Shipcase
3 = Roll
Max number of layers for orientation #1 allowed to the cargo.
Max number of layers for orientation #2 allowed to the cargo.
Max number of layers for orientation #3 allowed to the cargo.
Max number of layers for orientation #4 allowed to the cargo.
Max number of layers for orientation #5 allowed to the cargo.
Max number of layers for orientation #6 allowed to the cargo.
A number of pieces inside the cargo.
Unit price of the cargo.
Alias 1 of the cargo.
Alias 2 of the cargo.
Property 1~10 of the cargo.
Max supporting weight of the cargo.
Color of the cargo.

Understanding the Cargo Data Source and Cargo Data Source window
The cargo data source is a file or storage locates the cargo information. Once the data source is defined, all
further setup of new loads in CubeMaster program will bring the cargoes from it. CubeMaster provides the
multiple options for helping you dealing multiple data sources.
The cargo data source can be changed and customized at the Cargo Data Source window as picture below. It
is opened by two locations. Please choose Cargo Data Source under the Tools top menu or press [Change
data source] button on the [Add From Cargo Database] window.

Figure 4 Cargo Data Source Window

The available options in the Cargo Data Source window are listed below.
 Default database (MS Access 2007 or MS SQL Server 2007): This option locates a local database
with CubeMaste data scheme. To select this option as a current data source, press OK button after
activating the [Default database] check box. You can choose a different CubeMaster database file
existing in other locations such as the network folder.
 Predefined MS-Excel file: This option locates an Excel file with pre-defined columns. To select this
option as a current data source, press OK button after activating the [Predefined MS-Excel file] check
box. Please enter the name of your Excel file if necessary. The default file is ‘C:\Documents and
Settings\All Users\Logen\Shared\Doc\Cargoes.xls’ or
‘C:\ProgramData\Logen\Shared\Doc\Cargoes.xls’ created during the installation of the program.
 Customizable Excel or CSV file: This option locates an Excel or CSV file with custom defined
columns. To select this option as a current data source, press OK button after activating the
[Customizable Excel or CSV file] check box. Please change the settings of the Excel/CSV Import
Wizard with pressing [New] button if necessary. The default file is ‘C:\Documents and Settings\All
Users\Logen\Shared\Doc\Packages.csv’ or ‘C:\ProgramData\Logen\Shared\Doc\Packages.csv’
created during the installation of the program. For more detail about the Excel/CSV Import Wizard,
please refer the previous section [Another simple way using the Excel/CSV Import Wizard].
 Your Database with OLEDB access: This option locates a RDBMS database. To select this option
as a current data source, press OK button after activating the [Your Database with OLEDB access]
check box. Please change the settings of the External RDBMS Import Wizard with pressing [New]
button if necessary. For more detail about the External RDBMS Import Wizard, please refer the
previous section [Importing from your existing DBMS to CubeMaster cargoes database].
 XML file: This option locates a XML with predefined tags and data presenting the cargoes
information. To select this option as a current data source, press OK button after activating the [XML]
check box. The default is ‘C:\Documents and Settings\All Users\Logen\Shared\Doc\Cargoes.xml’ or
‘C:\ProgramData\Logen\Shared\Doc\Cargoes.xml’ created during the installation of the program.

The contents of the XML looks like below picture.
<Cargoes>
<Line No="1">
<SKU>WE 12500</SKU>
<Qty>3</Qty>
<Length>120</Length>
<Width>185</Width>
<Height>100</Height>
<Weight>2.5</Weight>
<Orientation>3</Orientation>
</Line>
<Line No="2">
<SKU>PH 14740</SKU>
<Qty>3</Qty>
<Length>120</Length>
<Width>185</Width>
<Height>100</Height>
<Weight>2.5</Weight>
<Orientation>3</Orientation>
</Line>
<Line No="3">
<SKU>WE 17850</SKU>
<Qty>3</Qty>
<Length>120</Length>
<Width>185</Width>
<Height>100</Height>
<Weight>2.5</Weight>
<Orientation>3</Orientation>
</Line>
</Cargoes>

The tags inside the <Line> tag should include the fields as summarized at following table.
Tags
GroupName
Name
Length
Width
Height
Weight
Qty
SetRatio
Orientation

PieceInside
UnitPrice
MaxLayersExtended

TurnAllowedOnFloor

Seq
MaxLayer1

Descriptions
Group name of the cargo.
Name of the cargo.
Length of the cargo.
Width of the cargo.
Height of the cargo.
Weight of the cargo.
Number of the cargo.
Set ratio of the cargo.
Numbers to present the loading orientation of the cargo allowed. One
of the following numbers are available.
1 = Permits orientation #1
2 = Permits orientation #2
3 = Permits orientation #1 and #2
4 = Permits orientation #3
8 = Permits orientation #4
12 = Permits orientation #3 and #4
16 = Permits orientation #5
32 = Permits orientation #6
63 = Permits all orientations (#1,2,3,4,5,6)
A number of pieces inside the cargo.
Unit price of the cargo.
A number to present whether the max layers of the cargo are
extended on the other cargoes. One of the following numbers
are available.
0 = No
1 = Yes
A number to present whether the turning orientations of the
cargo are allowed on the floor of the container or not. One of the
following numbers are available.
0 = No
1 = Yes
Loading order of the cargo.
Max number of layers for orientation #1 allowed to the cargo.

MaxLayer2
MaxLayer3
MaxLayer4
MaxLayer5
MaxLayer6
Alias1
Alias2
StackValue
FloorStackType

SupportsOthers

Max number of layers for orientation #2 allowed to the cargo.
Max number of layers for orientation #3 allowed to the cargo.
Max number of layers for orientation #4 allowed to the cargo.
Max number of layers for orientation #5 allowed to the cargo.
Max number of layers for orientation #6 allowed to the cargo.
Alias 1 of the cargo.
Alias 2 of the cargo.
Stack Value of the cargo.
A number to present the floor stacking type of the cargo. One of
the following numbers are available.
0 = Best Fit
1 = Bottom Only
2 = No Bottom
A number to present whether the cargo is allowed to support
other cargoes or not. One of the following numbers are
available.
0 = No
1 = Yes

Importing Truck and Container Sizes from External Database
If you like to import containers data from an external database such as a RDBMS, you need to define a new
data source. The data source is a file, storage or connection with SQL where the data is queried automatically
when the Container (Truck, Sea Van, Pallet or Carton) Database Dialog opens. The default data source is a
Microsoft Access 2007 file ‘C:\ProgramData\Logen\Shared\Database\VMSDB2010.mdb’ which was
created during the installation.
To define new data source, use the Container Data Source dialog as pictured below. To display this screen,
choose Container Data Source under the Tools menu.

Figure 5 Cargo Data Source Dialog

The available data sources in the cargo Data Source dialog are as below.
 Default database (MS Access 2007 or MS SQL Server 2007): This source is a local MDB file. To
determine this as current data source, activate the [Default database] check box and enter the file
name, where you will browse from, into the field at below of the check box. The default filename is
‘C:\Documents and Settings\All Users\Logen\Shared\Database\VMSDB2010.mdb’, which was
created during the installation of the program.
 Query (OLEDB): This source is an OLEDB. To determine this as a current data source, activate the
[Query (OLEDB)] check box and enter the statement of connection and SQL into the field
[Connections] and [SQL] respectively.
The connection statement should contain the provider of the OLEDB data source which points to
the database name where your legacy data exists. The default connection is
“Provider=SQLOLEDB.1; Persist Security Info=False; User ID=guest; PWD=guest; Initial
Catalog=CubeMaster2006; Data Source=www.logen.co.kr”, which points to the sample database
created already at the Logen Solutions data server.
The default statement is “select type as type, name as name, alias as alias, in_length as in_length,
in_width as in_width, in_height as in_height, out_length as out_length, out_width as out_width,
out_height as out_height, weight as weight from VMS_CONTAINER where domain_id =
'LOGENS' order by name” which queries container data from the connection. Here in the statement,
the field name (or its alias) should be the same as reserved one. The reserved field names are
summarized at following table.

Cell Text
Name
In_Length
In_Width
In_Height
Out_Length
Out_Width
Out_Height
Weight
Alias
Type

Description
Name of container
Inside Length of container
Inside Width of container
Inside Height of container
Outside Length of container
Outside Width of container
Outside Height of container
Weight of container (Empty weight)
Description of container
Type of container. The following values are available.
 ‘CNT’: Sea Container
 ‘TRK’: Truck
 ‘PLT’: Pallet
 ‘ULD’: Air Container

If you click the [Load Query] button, the saved connections and the SQL statement will be loaded
from a file. And if you click the [Save Query] button, the current connections and SQL statement
will be saved to a file.

Creating a New Load from Order XML
You can define a new load from a XML after importing to CubeMaster program. Use the Notepad program
to open the sample XML file ‘C:\ProgramData\Logen\Shared\Doc\Order sample for sea containers.xml’ and
fill with your definition. Or your existing application such as WMS or ERP could create a XML in your
network drive.
If you click the ‘New From XML’ menu under the File menu, you will be allowed to choose a XML file at
the File Open window. Once a XML file is open, the Setup View shows the contents automatically and
allows you to see and change them. Just pressing F5 will start the calculation.
The following picture shows the sample of an order XML.
<?xml version="1.0" encoding="UTF-8" ?>
<Order Title="ABC123" Description="Sample Order">
<Containers Type="CNT">
<Line No="1">
<Name>40FTDC</Name>
<Qty>0</Qty>
<Length>12050.0</Length>
<Width>2340.0</Width>
<Height>2370.0</Height>
<Weight>0</Weight>
<MaxWeight>0</MaxWeight>
</Line>
<Line No="2">
<Name>20FTDC</Name>
<Qty>0</Qty>
<Length>5890.0</Length>
<Width>2340.0</Width>
<Height>2370.0</Height>
<Weight>0</Weight>
<MaxWeight>0</MaxWeight>
</Line>
</Containers>
<Cargoes>
<Line No="1">
<Name>WE 12500</Name>
<Qty>34</Qty>
<Length>500</Length>
<Width>585</Width>
<Height>800</Height>
<Weight>2.5</Weight>
<Orientation>3</Orientation>
</Line>
<Line No="2">
<Name>PH 14740</Name>
<Qty>53</Qty>
<Length>820</Length>
<Width>985</Width>
<Height>600</Height>
<Weight>2.5</Weight>
<Orientation>63</Orientation>
</Line>
<Line No="3">
<Name>WE 17850</Name>
<Qty>63</Qty>
<Length>1320</Length>
<Width>1435</Width>
<Height>700</Height>
<Weight>2.5</Weight>
<Orientation>63</Orientation>
</Line>
</Cargoes>
<Rules>
<IsGroupUsed>0</IsGroupUsed>
<IsSequenceUsed>0</IsSequenceUsed>
<IsSafeStackingUsed>1</IsSafeStackingUsed>
<MinSupportRate>50</MinSupportRate>
<IsPalletized>0</IsPalletized>
<IsBestFitContainersSelection>1</IsBestFitContainersSelection>
<IsWeightLimited>1</IsWeightLimited>
<StackingRule>100</StackingRule>
<FillDirection>0</FillDirection>
</Rules>
<Options>
<UOM>1</UOM>
</Options>
</Order>

The following table shows the specification what an order XML should has.

Tag

Description

Available Values

Order
Title

Title for a load

Description

Description for a load

Containers

Containers information for Step 1

Type

The type of the containers

Sea Container = CNT,
Pallet = PLT,
Truck = TRK,
Carton = BOX,
Air Pallet = ULD

Line
No

A sequence in the containers list

Name

Name of the container

Qty

Amount of the container

Length

Length of the container

Width

Width of the container

Height

Height of the container

Weight

Weight of the container (Empty weight)

MaxHeight

Max height of the pallet

MaxWeight

Max weight of the container including the empty weight

Cargoes

Cargoes information for Step 2

Line
No

A sequence in the cargoes list

Name

Name of the cargo

Qty

Amount of the cargo

Length

Length of the cargo

Width

Width of the cargo

Height

Height of the cargo

Weight

Weight of the cargo

Orientation

1 = Permits orientation #1
2 = Permits orientation #2
3 = Permits orientation #1 and #2
4 = Permits orientation #3
A number to present the loading orientation
8 = Permits
allowedorientation #4
12 = Permits orientation #3 and #4
16 = Permits orientation #5
32 = Permits orientation #6
63 = Permits all orientations (#1,2,3,4,5,6)

Palletizing

Pallet configuration for the palletizing this cargo

Pallet

Name of the pallet to be filled for the palletizing

Rules

Rules information for the More Rules

IsGroupUsed

Keep same groups together (Use the cargo
0/1gorups) or not

IsSequenceUsed

Load by sequence (Cargoes with low sequences
0/1
placed earlier) or not

IsSafeStackingUsed

Use safe stacking or not

MinSupportRate

Minimum supporting rate in percent forNumber
the safe in
stacking
percentage

IsPalletized

Palletized or not before loading vehicles0/1

Palletizing

Palletizing information

MixPallet

0/1

Name of the pallet to be filled with the different cargoes for the palletizing

IsBestFitContainersSelection

Select the multiple containers from the best
0/1 selection rule or not

IsWeightLimited

The max weight of the containers are limited
0/1 or not

StackingRule

FillDirection
Options
UOM

BestFit = 100,
HigherStackValueBottomFirst = 1,
AllowedTopBottmStackValueSame = 2,
AllowedTopBottomFootPrintSame = 3,
A number to present the stacking rules
HeavierBottomFirst = 4,
FloorStack = 5,
FollowStackMatrix = 6,
AlwaysNotAllowed = 101
FrontToRear=0,
BottomToTop=2,
A number to present the filling directions
ColumnStack=0,
LayerStack=2
Settings
A number to present the UOM

English (Inch + Lbs) = 0,
Metric (mm + Kg) = 1,
HighMetric (Cm + Kg) = 2

Figure 6 Specification of the Order XML

Exporting Solutions
CubeMaster allows you to export solutions to a Microsoft Excel sheet, an XML file or an ASCII comma
delimited text file. You can use this file to transfer the solutions to other program such as ERP or WMS.
To export solutions from the CubeMaster system, follow these instructions:
1.

Export to a Microsoft Excel sheet: From the Menu Bar, open the File menu and select Export to
Microsoft Excel File. In a few seconds, a new MS Excel program opens and shows three new sheets –
Load Summary, Solutions and Loading Guide. You can save the Excel sheets to a new file by selecting
the Save under the File menu at the Microsoft Excel program.

2.

Export to an XML file: From the Menu Bar, open the File menu and select Export to XML. The New
File dialog window opens and prompts a file name. Just pressing [Open] button after entering a new file
name at a desired folder, a new XML file is created at your computer.

3.

Export to an ASCII file: From the Menu Bar, open the File menu and select Export to Text File. The
New File dialog window opens and prompts a file name. Just pressing [Open] button after entering a
new file name at a desired folder, a new text file is created at your computer.

